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Introduction 

The default online analytical processing (OLAP) cubes that are provided with Microsoft Dynamics® AX 
require full license and configuration keys. If any license or configuration key is turned off, you must 
complete the procedures in this white paper. The procedures in this white paper will help you 
configure the cubes to work with the license and configuration keys you are using. 

Why you need to use this white paper 

Functionality in Microsoft Dynamics AX can be turned on or off depending on license and configuration 
keys. 

 A license key controls the modules that are available to you. For example, if you have the 

Additional Modules license, you can use the Human Resources I and Human Resources II modules. 

License keys must be purchased. 

 A configuration key controls the functionality that is available to you within a module. For 
example, if you have the Recruiting (HRMMangementRecruting) configuration key, you can use the 
recruiting forms and functionality in the Human Resources II module. 

The default OLAP cubes that are provided with Microsoft Dynamics AX require full license and 
configuration keys. When you turn off license or configuration keys, or when some keys are missing, 
data and functionality in Microsoft Dynamics AX is removed. As a result: 

 Cubes cannot be processed (because they cannot access the data they were designed to retrieve). 

 Errors are displayed in the Role Center web parts that use cubes. 

 

The procedures in this white paper will help you modify the cubes so that they no longer try to 
retrieve data that depends on missing license or configuration keys. This white paper will also help you 
modify Role Center pages so that they do not display errors. 
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Who should complete the procedures in this white paper 

The procedures in this white paper are complex and should be completed by software developers or 
system implementers.  

To complete the procedures in this white paper, you must: 

 Be familiar with SQL Server Analysis Services. 

 Have a good understanding of the Microsoft Dynamics AX relational architecture. 

 Have experience modifying OLAP projects in SQL Server Business Intelligence Development 
Studio. 

When you should use this white paper 

Before you complete the procedures in this white paper, it is critical that you have determined the 

license and configuration keys you need for your Microsoft Dynamics AX implementation. Enter the 
license and configuration keys before you complete the procedures in this white paper. For more 

information about entering license and configuration keys, see Complete prerequisite procedures. 

If you complete the procedures in this white paper, and then later turn off a license or configuration 
key, you may need to complete these procedures again. 

What is in this white paper 

The following diagram shows the procedures that must be completed to configure the default OLAP 
cubes. 

Enter license and 

configuration keys

Synchronize the 

OLTP database

Synchronize the 

OLAP database

Update the OLTP 

database with BI 

data

Modify cubes
Modify Role Center 

pages

Prerequisite procedures Procedures you must complete using this white paper

Update cubes with 

exchange rate 

information

Set up a SQL 

Server batch to 

process the cubes

Configure security 

for the cubes

Procedures the system administrator must complete

 

Prerequisite procedures 

Before you complete the procedures in this white paper, you or your Microsoft Dynamics AX system 
administrator must: 

 Enter license and configuration keys   Enter the license and configuration keys that you need 

for your Microsoft Dynamics AX implementation. Complete this procedure using the Microsoft 
Dynamics AX client. 

 Synchronize the OLTP database   The database that stores your Microsoft Dynamics AX data is 
classified as an online transaction processing (OLTP) database, and will be referred to here as the 

OLTP database. Synchronize the OLTP database using the Microsoft Dynamics AX client. The 
synchronization process will add or remove columns and tables from the OLTP database based on 
the license and configuration keys you are using. 

For more information about the prerequisite procedures, see Complete prerequisite procedures. 
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Procedures you must complete using this white paper 

The procedures in this white paper will help you modify the cubes so that they no longer try to 
retrieve data that depends on missing license or configuration keys. This white paper will also help you 

modify Role Center pages so that they do not display errors. Here are the procedures you must 
complete: 

 Update the OLTP database with BI data   Update your OLTP database with business 
intelligence (BI) data, including currency conversion information and time dimensions. Complete 

this procedure using the Microsoft Dynamics AX client. For more information, see Update the OLTP 
database with BI data. 

 Synchronize the OLAP database   Synchronize your OLAP database with the schema from the 
OLTP database. During the synchronization process, columns and tables that do not exist in the 
OLTP database (due to license and configuration key settings) will be removed from the Analysis 

Services data source view (DSV). Complete this procedure using the Microsoft Dynamics AX client. 

For more information, see Synchronize the OLAP database. 

 Modify cubes   Create a new OLAP project and modify the cubes so that they no longer try to 
retrieve data that relies on missing license or configuration keys. Modify the cubes using 

Microsoft® SQL Server® Business Intelligence Development Studio. For more information, see 
Modify the cubes. 

 Modify Role Center pages   Modify and delete web parts on Role Center pages so that they do 
not display errors. Complete this procedure using Enterprise Portal. For more information, see 

Modify Role Center pages. 

Procedures the system administrator must complete 

There are some setup procedures your Microsoft Dynamics AX system administrator must complete to 
set up and maintain the cubes. These procedures include: 

 Update cubes with exchange rate information   Update the cubes with exchange rates and 

set up a Microsoft Dynamics AX batch to update the cubes with this information on a regular basis. 
Complete this procedure using the Microsoft Dynamics AX client. 

 Set up a SQL Server batch to process the cubes   Set up a SQL Server batch to process the 

cubes on a regular basis so that they are up-to-date and contain the latest data. 

 Configure security for the cubes   Security for OLAP data is set up independently from 
Microsoft Dynamics AX security. Within an instance of Analysis Services, user access to objects 
such as cubes and dimensions is granted through membership in one or more database roles. The 
system administrator must assign the Microsoft Dynamics AX users to these roles. 

For more information about the procedures your Microsoft Dynamics AX system administrator must 
complete, see Final steps. 

How much time is required 

The time you will spend on each procedure in this white paper depends on your level of experience 

with cubes, your level of experience using the Business Intelligence Development Studio, and the 
number of cubes and Role Center pages you’ll need to modify. 

Here are some time estimates to help in your planning: 

Procedure Estimated time 

Synchronize the OLAP database 30-60 minutes 

Modify cubes 2-4 hours 

Modify Role Center pages 1-3 hours 
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Complete prerequisite procedures 

Before you complete the procedures in this white paper, it is critical that you have determined the 
license and configuration keys you need for your Microsoft Dynamics AX implementation. You must: 

 Enter license and configuration keys 

For instructions on how to enter license keys, see the “Provide license information” section in the 
Microsoft Dynamics AX Installation Guide. 

For instructions on how to enter configuration keys, see the “Configure application functionality” 
section in the Microsoft Dynamics AX Installation Guide. 

 Synchronize the OLTP database 

When you synchronize the OLTP database, the synchronization process will add or remove 
columns and tables from the database based on the license and configuration keys you are using. 

For instructions on how to synchronize the OLTP database, see the “Synchronize the database” 
section in the Microsoft Dynamics AX Installation Guide. 

Update the OLTP database with BI data 

The following procedure explains how to update your OLTP database with business intelligence (BI) 
data, including currency conversion information and time dimensions.  

You must complete this procedure when you are initially setting up the cubes. If you add a fiscal 

period at a later time, you must complete this procedure again. 

Note: Before completing this procedure, we recommend that you make a backup of your OLTP 
database. 

1. Open your Microsoft Dynamics AX client (Start > Programs > Microsoft Dynamics AX 2009 > 
Microsoft Dynamics AX 2009). 

2. Open the OLAP Administration form (Administration > Setup > Business analysis > OLAP 
> OLAP Administration).  

3. Click the Advanced tab.  

4. Select the Update BI Data check box. 

 

5. Click Update Databases to update the OLTP database with currency conversion information and 
time dimensions. 

http://go.microsoft.com/fwlink/?LinkID=99623
http://go.microsoft.com/fwlink/?LinkID=99623
http://go.microsoft.com/fwlink/?LinkID=99623
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Synchronize the OLAP database 

Complete the following procedure to synchronize the Dynamics AX OLAP database with the schema 
from the OLTP database. During the synchronization process, columns and tables that do not exist in 
the OLTP database (due to license and configuration key settings) will be removed from the Analysis 
Services data source view (DSV). 

Note: Before completing this procedure, we recommend that you make a backup of your OLAP 

database. 

1. Open your Microsoft Dynamics AX client (Start > Programs > Microsoft Dynamics AX 2009 > 
Microsoft Dynamics AX 2009). 

2. Open the OLAP Administration form (Administration > Setup > Business analysis > OLAP 
> OLAP Administration).  

3. Click the OLAP servers tab.  

4. Enter the name and a description of the server that is running Analysis Services. (This information 

may be already entered for you.) 

5. Select the check box for the OLAP server.  

 

6. Click the OLAP databases tab.  

7. In the Database name field, enter Dynamics AX. (This information may be already entered for 
you.)  

By default, the OLAP database that stores the Microsoft Dynamics AX cubes is named Dynamics 
AX. 
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8. Select the check box for the OLAP database. 

 

9. Click the Advanced tab.  

10. Select the Synchronize OLAP Database with OLTP Schema check box. 

11. Select the Enable logging check box.  

Data will be recorded in a log file. Specify an existing location to save the log file to.  

Note: You will need to refer to this log file when completing many of the procedures in this white 

paper. 
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12. Click Update Databases to synchronize the OLAP database with the schema from the OLTP 
database. This process may take an hour or more to complete. 

 

 

 
The synchronization process does: 

1. Compares the schema in the OLTP database to 

the schema in the OLAP database. 

2. Removes tables from the data source view if 

the corresponding tables in the OLTP 

database were removed (due to license and 

configuration key settings). 

3. Removes orphaned relationships contained in 

the data source view. 

4. Removes invalid dimensions and dimension 

attributes. 

5. Removes invalid measures and measure 

groups. 

The synchronization process warns: 

1. When a named query in the data source view 

may be broken. For example, the named 

query may refer to a column or table that was 

removed from the OLTP database. 

2. When a dimension refers to a named query 

that may be broken. 

3. When a measure group refers to a named 

query that may be broken. 
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Modify the cubes 

The next step in the process is to create a new OLAP project and modify the cubes so that they no 
longer try to retrieve data that is absent because of missing license or configuration keys.  

Complete the following procedures: 

 Create a new OLAP project 

 Delete the cubes that you do not need 

 Review the log file 

 Update named queries 

 Repair or remove invalid dimensions 

 Update cube elements 

 Deploy the OLAP project 

Create a new OLAP project 

Complete the following procedure to create a new OLAP project in the SQL Server Business 
Intelligence Development Studio. You will use this new project to modify the cubes. 

1. Open the Business Intelligence Development Studio (Start > Programs > Microsoft SQL Server 
> SQL Server Business Intelligence Development Studio). 

2. Click File > New > Project. The New Project window is displayed. 

3. In the Templates pane of the window, select the option to import an Analysis Services database. 

4. At the bottom of the New Project window, in the Name field, enter Dynamics AX. 

5. In the Location field, specify where you want to save the project. 

6. Click OK. A wizard is displayed to help you import the Dynamics AX OLAP database.  

7. In the Welcome window, click Next. 

8. In the Source database window, do the following: 

a) Enter the name of your OLAP server. 

b) Select the Dynamics AX database. 

c) Click Next. 

9. When the database has been imported, click Finish.  

Your new project is available in the Solution Explorer pane of the Business Intelligence 
Development Studio. Leave this project open. You will use this project to complete many of the 

procedures in this document. 
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Delete the cubes that you do not need 

Based on your license and configuration keys, determine which cubes you need. Delete the cubes that 
are not applicable to you based on your license and configuration keys. 

1. Open the Excel CrossRef.xlsx file. You can download this file at 
http://go.microsoft.com/fwlink/?LinkID=124933&clcid=0x409.  

2. Go to the Home tab. 

3. Make sure that the License group, Module, and Configuration key columns are not filtering 
out any data. 

4. Sort the contents of the worksheet by the Cube column.  

5. The Sort Warning dialog box may appear. Select Expand the selection and click OK. 

6. Go to the Cube column. Note the modules each cube is associated with. If a cube is associated 
with modules that you do not use, you can delete the cube.  

For example, you will notice that the Customer Relationship Management cube is associated with 
the Marketing Automation, Sales Force Automation, and Sales Management modules. If you do not 
use any of these modules, you can delete the Customer Relationship Management cube. 

7. To delete a cube, do the following: 

a) In the Business Intelligence Development Studio, go to the Solution Explorer pane. 

b) Expand the Cubes folder. 

c) For each cube that you do not need, right-click the cube and choose Delete. 

Review the log file 

With a text editor, open the log file that was generated during the Synchronize the OLAP database 
procedure. 

 

http://go.microsoft.com/fwlink/?LinkID=124933&clcid=0x409
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Informational messages 

During the Synchronize the OLAP database procedure, columns and tables that do not exist in the 
OLTP database (due to license and configuration key settings) are removed from the Analysis Services 
data source view (DSV). As a result, you will notice the following types of informational messages in 
the log file. 

These messages are provided for informational purposes only. You do not need to take any action 
based on these messages. 

Object Message text Description 

DSV Reading metadata in data source view 'Dynamics AX' 
for table 'EMPLTABLE'  

Indicates that metadata for a table in 
the data source view is being read. 

DSV Removing relation 
'VENDPAYMMODETABLE_BASEENUM_NoYes_3_1033' 

Indicates that an invalid relation has 
been deleted from the data source 
view. 

DSV Removing column 'ABSENCESETUPID' of table 
'HRMPARTYEMPLOYEERELATIONSHIP' 

Indicates that an invalid column has 
been deleted from a table. 

DSV Removing table 'HRMGOAL' Indicates that an invalid table has been 
deleted from the data source view. 

Cube  Removing invalid cube dimension 'Company 
information' from cube 'Accounts Receivable Cube' 

Indicates that a dimension has been 
deleted from a cube.  

Cube  Removing invalid measure group 'Goals' from cube 
'Human Resource Management Cube' 

Indicates that an invalid measure group 
has been deleted from a cube. 

Dimension Removing invalid attribute 'Cost percentage' from 
dimension 'Line property' 

Indicates that an invalid attribute has 
been removed from a dimension. 

Dimension Removing invalid dimension 'Activities' Indicates that an invalid dimension has 
been removed. 

 



 

 

13 
 

CONFIGURING THE DEFAULT OLAP CUBES 

 

Warning messages 

The Synchronize the OLAP database procedure does not remove invalid columns from named queries. 
(An invalid column is a column that no longer exists in the OLTP database due to license and 
configuration key settings.) As a result, you will notice the following types of warning messages in the 
log file. 

The procedures in this white paper will help you resolve these warning messages. 

Object Message text What you need to do… 

DSV Warning: table 'KMACTION' in data source view 
'Dynamics AX' contains one or more invalid column 
references in its QueryDefinition property. This must 

be corrected prior to processing the database. 

You may need to update the named 
query, KMACTION, in the data source 
view. For more information, see Update 

named queries. 

Dimension Warning: dimension 'Actions' refers to data table 
'KMACTION' which has an invalid query definition. 
After fixing the query definition you may need to 
modify this dimension. 

You may need to update the dimension, 
Actions (which refers to the named 
query, KMACTION). For more 
information, see Repair or remove 
invalid dimensions. 

Cube Warning: measure group 'Actions' of cube 'Human 
Resource Management Cube' refers to data table 
'KMACTION' which has an invalid query definition. 
After fixing the query definition you may need to 
modify this measure group. 

You many need to update the Actions 
measure group (which refers to the 
named query, KMACTION) in the 
Human Resources Management cube. 
For more information, see Remove 
invalid measures. 

 

Keep the following points in mind when reviewing warning messages: 

 A warning message doesn’t necessarily mean that there is an error you need to resolve in the 

OLAP project. A warning message indicates closer investigation is needed. 

 Ignore warning messages that pertain to the cubes you deleted.  

 Ignore warning messages that refer to a table that starts with the letters TFF. For example, the 

following warning message should be ignored: 

Warning: table 'TFF2353_R1_2353_103' in data source view 'Dynamics AX' contains one or more 
invalid column references in its QueryDefinition property. 

 Warning messages that refer to dimensions should be investigated further. Your investigation 

should determine if the dimensions are associated with the cubes that you need to modify. 

 Warning messages that refer to tables are only important if those tables contain data for the 
cubes (and dimensions) that you need to modify.  
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Update named queries 

Use the following procedures to identify an invalid named query and to update it. 

To identify an invalid named query 

To identify an invalid named query, use the Default Cube Advisor Tool or complete the following tasks. 
(A CustomerSource login is required to access the Default Cube Advisor Tool.) 

 Determine which tables—with named queries—generated warning messages 

Using the log file that was generated in the Synchronize the OLAP database procedure, identify 

which tables—with named queries—generated warning messages.  

For example, look for the following type of message in the log file: 

Warning: table 'KMACTION' in data source view 'Dynamics AX' contains one or more invalid 
column references in its QueryDefinition property. This must be corrected prior to processing the 
database. 

 Determine if those tables contain data used by your cubes 

For each table that generated a warning message, determine if that table contains data used by a 
cube that you need. To determine this, open the Excel CrossRef.xlsx file. Search the entire 
workbook for the table name. 

 

For example, you will find that the KMACTION table contains data used by the Human Resource 

Management cube. If you need this cube, you must update the named query for the KMACTION 
table. 

To update a named query 

Complete the following steps to update a named query. 

1. In the Solution Explorer pane, expand the Data Source Views folder. 

2. Double-click the Dynamics AX.dsv file to open the data source view in design mode. 

3. In the Tables pane, locate the table. 

4. Right-click the table and select Edit Named Query. The Edit Named Query window is displayed. 

Search the entire 

workbook. 

http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkID=124933&clcid=0x409
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5. Click the Run button to display information about invalid columns and tables. 

 

An error message is displayed. In this example, invalid columns and an invalid table are 
included in the named query. 

 

6. Remove invalid columns and tables from the named query. You can remove invalid columns and 
tables in one of the following ways: 

 Clear the Output checkbox for an invalid column. Some invalid columns have the word 

<Unknown> listed as their table name. 

-Or- 

 Copy the SQL statement to a SQL query editor, such as the one in SQL Server Management 

Studio (To access the query editor in SQL Server Management Studio, click File > New > 
Query with Current Connection). Modify the SQL statement until it can be executed without 
errors. Then copy the modified SQL statement back into the Edit Named Query window. 

7. Repair or remove invalid join conditions from the named query.  

Warning: Removing a join condition may change the intended query meaning and result in 
incorrect data being returned. 

8. Save the named query by clicking OK. 

Run button 
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Repair or remove invalid dimensions 

Use the following procedures to identify an invalid dimension and to repair or remove it. 

To identify an invalid dimension 

To identify an invalid dimension, use the Default Cube Advisor Tool or complete the following tasks. (A 
CustomerSource login is required to access the Default Cube Advisor Tool.) 

 Determine which dimensions generated warning messages 

Using the log file that was generated in the Synchronize the OLAP database procedure, identify 
which dimensions generated warning messages.  

For example, look for the following type of message in the log file: 

Warning: dimension 'Actions' refers to data table 'KMACTION' which has an invalid query 
definition. After fixing the query definition you may need to modify this dimension. 

 Determine if those dimensions are used by your cubes 

For each dimension that generated a warning message, determine if that dimension is used by a 
cube that you need. To determine this, open the Excel CrossRef.xlsx file. Go to the Dimensions 
worksheet and search for the dimension name. 

 

For example, you will find that the Actions dimension is used by the Human Resource 
Management cube. If you need this cube, you must repair or remove the Actions dimension. 

To repair or remove an invalid dimension 

Complete the following steps to repair or remove an invalid dimension. 

1. In the Solution Explorer pane, open an invalid dimension by double-clicking the dimension. 

The Dimension Structure tab is displayed. 

 

Go to the Dimensions 

worksheet and search for 

the dimension name. 

http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkID=124933&clcid=0x409
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2. Go to the Attributes pane. 

 If there are no attributes listed, delete the dimension. Delete the dimension by right-clicking it 

in the Solution Explorer pane and selecting Delete. 

 If an attribute is invalid, indicated by a red underline, delete the attribute. Delete the attribute 
by right-clicking it and selecting Delete. 

For example, the Action types and Contact persons attributes shown in the previous screen 

illustration should be deleted. 

Note: If a key attribute is invalid, we recommend you delete the entire dimension. For 
example, in the previous screen illustration, the Actions attribute is a key attribute. Because 
this attribute is invalid, the entire dimension should be deleted. 

3. Go to the Hierarchies or Hierarchies and Levels pane. If a hierarchy has no levels, delete the 
hierarchy. Delete the hierarchy by right-clicking it and selecting Delete. 

4. Save your changes. 

5. To verify that the dimension is now valid, process the dimension by doing the following: 

a) Go to the Solution Explorer pane.  

b) Right-click the dimension and select Process.  

c) You may be prompted to build and deploy the project. Click Yes. 

d) The Process Dimension - <Dimension Name> window is displayed. Click Run. 

The Process Progress window is displayed. When the processing is complete, the Status 

area of the window should display Process succeeded if the dimension is valid. 
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Update cube elements 

Cube elements become invalid if their underlying columns or tables are missing from the schema. 
Cube elements must be updated or removed so that they do not reference missing schema elements. 

The following procedures will help you update elements of a cube. Complete these procedures for each 
of your cubes. 

 Open a cube 

 Remove invalid measures 

 Update dimension usage 

 Process the cube 

 Repair or remove calculated measures 

 Repair or remove key performance indicators (KPIs) 

 Verify cube data 

Open a cube 

From the Solution Explorer pane in the Business Intelligence Development Studio, open a cube by 
double-clicking the cube. 

The cube is displayed in design mode. 

 

While the cube is in design mode, complete the following procedures to update the elements of the 

cube. 
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Remove invalid measures 

Use the following procedures to identify an invalid measure and to remove it. 

To identify an invalid measure 

To identify an invalid measure, use the Default Cube Advisor Tool or complete the following tasks. (A 

CustomerSource login is required to access the Default Cube Advisor Tool.) 

 Determine which measure groups generated warning messages 

Using the log file that was generated in the Synchronize the OLAP database procedure, identify 
which measure groups generated warning messages.  

For example, look for the following type of message in the log file: 

Warning: measure group 'Actions' of cube 'Human Resource Management Cube' refers to data 
table 'KMACTION' which has an invalid query definition. After fixing the query definition you may 
need to modify this measure group. 

 Determine if those measure groups are used by your cubes 

For each measure group that generated a warning message, determine if that measure group is 
used by a cube that you need. To determine this, open the Excel CrossRef.xlsx file. Go to the 
Measures worksheet and search for the name of the measure group. 

  

For example, you will find that the Actions measure group is used by the Human Resource 

Management cube. If you need this cube, you must remove the invalid measures within the 
Actions measure group (and possibly the entire Actions measure group). 

To remove an invalid measure 

Complete the following steps to remove an invalid measure. 

1. Click the Cube Structure tab. 

2. Expand the measure group. 

Go to the Measures 

worksheet and search for the 

name of the measure group. 

http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkID=124933&clcid=0x409
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3. Determine if the measures within that group are valid. To determine if a measure is valid, do the 
following: 

a) Right-click the measure and choose Properties. 

b) In the Properties pane, expand the Source > Source node.  

The column or table that this measure is mapped to is displayed. If the column or table no 
longer exists in the OLTP database (due to license and configuration key settings), you must 
delete the measure. 

 

4. Delete invalid measures. To delete a measure, go to the Measures pane. Right-click the measure 
and select Delete. 

5. Delete any measure groups that have no measures within them. To delete a measure group, right-
click the measure group and select Delete. 

6. Save your changes. 

The column and table the 

measure is mapped to are 

displayed here. 
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Update dimension usage 

Dimension usage defines the relationship between a measure group and a dimension that it can be 
sliced by. Dimension usage may need to be updated based on changes made to a dimension or to a 
measure group.  

Tip: BIDS Helper is an add-in tool that extends the functionality of the SQL Server Business 

Intelligence Development Studio. Using BIDS Helper, you can view and print a report encompassing all 
the information from the Dimension Usage tab. To download BIDS Helper, see 
http://www.codeplex.com/bidshelper. For information about how to print a report about dimension 
usage information, see 
http://www.codeplex.com/bidshelper/Wiki/View.aspx?title=Printer%20Friendly%20Dimension%20Usa
ge&referringTitle=Home.  

Complete the following procedure to update dimension usage. 

1. Click the Dimension Usage tab. 

Note: Dimension usage between a dimension and a measure group will be removed automatically 
if the dimension or the measure group has been removed. 

2. Modify dimension usage, if necessary. 

You must modify dimension usage if a dimension was changed in such a way that it affects how a 
measure group relates to the dimension. For example, if you removed a dimension attribute, you 

may need to modify the dimension usage. 

To modify the dimension usage between a dimension and a measure group, do the following: 

a) Select the field that intersects the dimension and the measure group and click the expansion 
button located in the field.  

 

 

b) In the Define Relationship window, specify the relationship between the dimension and the 
measure group. 

 

   Expansion button 

http://www.codeplex.com/bidshelper
http://www.codeplex.com/bidshelper/Wiki/View.aspx?title=Printer%20Friendly%20Dimension%20Usage&referringTitle=Home
http://www.codeplex.com/bidshelper/Wiki/View.aspx?title=Printer%20Friendly%20Dimension%20Usage&referringTitle=Home
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Typical changes may include modifying the relationship to remove columns that do not exist or 
changing columns that join the dimension to the measure group. Keep in mind that modifying 
the relationship can impact what data is returned by the cube. See the Analysis Services 
documentation for more details on defining dimension usage. 

c) Click OK. 

3. Delete dimension usage, if necessary.  

To delete dimension usage between a dimension and a measure group, click the field that 
intersects the dimension and the measure group. Press Delete. 

 

 

 

 

When you delete dimension usage, measure group data can no longer be sliced by that particular 

dimension. 

Process the cube 

Process the cube you are working with. This will help you to determine if there are calculated 
measures and KPIs that you need to repair or remove. (The next two sections of this white paper 
explain how to repair or remove calculated measures and KPIs.) 

1. In the Solution Explorer pane, right-click the cube you are working with. Click Process.  

2. You may be prompted to build and deploy the project. Click Yes. 

3. The Process Cube – <Cube Name> window is displayed. Right-click the Process Options 
column and select Add Related Dimensions to process the cube as well as the dimensions it 
uses. 

 

4. Click Run. 

The Process Progress window is displayed. When the processing is complete, the Status area of 
the window should display Process succeeded if the cube is valid. 

Note: A cube can process successfully even if its calculated measures and KPIs are invalid. Refer 
to the following procedures on how to repair or remove invalid calculated measures and KPIs. 

Field that intersects the dimension and 

the measure group. 
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Repair or remove calculated measures 

If you removed a measure in the Remove invalid measures procedure, you may need to repair or 
remove calculated measures that referred to that measure. Use the following procedures to identify an 

invalid calculated measure and to repair or remove it. 

To identify an invalid calculated measure 

To identify an invalid calculated measure, use the Default Cube Advisor Tool or use the cube browser. 
To use the cube browser, click the Browser tab. Then drag the calculated measures onto the report 
area. A calculated measure that returns an error, or displays no data may need to be repaired or 
removed. 

 

To repair or remove an invalid calculated measure 

Complete the following steps to repair or remove a calculated measure. 

1. Click the Calculations tab. 

2. Review each calculated measure and perform one of the following actions appropriate to your 
scenario: 

 Modify the calculated measure so that it does not have a dependency on a base measure that 
was removed. 

 Delete the calculated measure if it can no longer be supported without the base measure that 
was removed. 

3. Review each calculated measure and look for currency conversion queries. Verify that each 

measure and dimension used in a currency conversion query still exists. 

Warning: Currency conversion queries are executed at run time. If one of the measures or 
dimensions used in a currency conversion query has been removed, currency conversion will not 
be performed. Data will be displayed in the originating currency with no indication given to the 
user. 

Drag the calculated measures onto 

the report area. 

http://go.microsoft.com/fwlink/?LinkId=144755
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Repair or remove key performance indicators (KPIs) 

Complete the following procedure to repair or remove any KPIs that were affected by modifications 
you made to other cube elements.  

To identify an invalid KPI 

To identify an invalid KPI, use the Default Cube Advisor Tool or use the KPI browser. To use the KPI 

browser, click the Browser View icon, located on the toolbar of the KPIs tab. Review each KPI. Note 
the KPIs that do not return data, or those that display errors. You may need to modify or delete these 
KPIs. 

To repair or remove an invalid KPI 

Complete the following steps to repair or remove a KPI. 

1. Click the KPIs tab. 

2. Click the Form View icon, located on the toolbar of the KPIs tab. 

3. For each invalid KPI, perform one of the following actions appropriate to your scenario: 

 Modify the KPI so that it does not have a dependency on deleted cube and dimension 
elements. 

 Delete the KPI if it can no longer be supported due to changes made in the cube. 

Verify cube data 

Now that the invalid cube elements have been repaired or removed, we recommend that you verify 
that the cube returns the correct data. Compare the data returned by the cube to the data in the OLTP 

database. 

For example, you can use the cube browser to view cube data. Click the Browser tab. Then drag cube 
elements onto the report area. 

 

Verify that the data displayed is correct based on the data that is entered in the OLTP database. 

Drag cube elements onto 

the report area. 

http://go.microsoft.com/fwlink/?LinkId=144755
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Deploy the OLAP project 

After you have repaired or removed the invalid elements of each cube, deploy your OLAP project by 
completing the following steps. 

1. In the Solution Explorer pane, right-click the name of your OLAP project. 

2. Click Deploy. 

Modify Role Center pages 

Many of the Role Center pages have web parts, reports, and KPIs that rely on cubes. You’ll need to 
remove or repair these Role Center pages. 

 

To view the Role Center pages that are affected by cubes that you have modified, use the Default 
Cube Advisor Tool or complete the following steps. 

1. Open the Excel CrossRef.xlsx file. 

2. Go to the Home tab. 

3. Filter the License group column so that it displays the license that you are using. 

4. Filter the Module column so that it displays the modules that you are using. 

5. Filter the Configuration key column so that it displays the configuration keys that you have 
turned off.  

The Role Centers column of the worksheet now lists the Role Centers that you may need to 
modify. 

http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkID=124933&clcid=0x409
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To view the Role Center pages that are affected by cubes that you have deleted, use the Default Cube 
Advisor Tool or complete the following steps. 

1. Open the Excel CrossRef.xlsx file. 

2. Go to the Home tab. 

3. Filter the Cube column so that it displays the cubes you deleted. 

The Role Centers column of the worksheet now lists the Role Centers that you may need to 
modify. 

For detailed instructions about modifying Role Centers, see the “Modify Role Center pages” topic in the 
Enterprise Portal online help. You can access the Enterprise Portal online help by clicking the Help icon 
in the top-right corner of each Enterprise Portal page.  

Final steps 

The procedures in this white paper have explained how to: 

 Configure the cubes to work with the license and configuration keys you are using. 

 Remove web parts and reports (from Role Center pages) that referred to cubes that you deleted. 

There are some additional procedures your Microsoft Dynamics AX system administrator should 

complete to set up and maintain the cubes. These procedures are listed in the following table. 

Task For more information 

Update cubes with exchange rate 
information, and set up a batch to update 
the cubes with this information on a 
regular basis. 

See the “Update cubes with exchange rate information” topic in the 
System and Application Setup help file. 

To access the System and Application Setup help file, open your 
Microsoft Dynamics AX client and click Microsoft Dynamics AX > 
Help > System and Application Setup.  

Create a SQL Server batch to process the 
cubes on a regular basis. 

See the SQL Server documentation on MSDN. 

Configure security for cubes. See the “Configure security settings for cubes” topic in the System 
and Application Setup help file. 

 

http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkId=144755
http://go.microsoft.com/fwlink/?LinkID=124933&clcid=0x409
http://msdn.microsoft.com/
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Appendix: Default Cube Advisor Tool 

Use the Default Cube Advisor Tool for Microsoft Dynamics AX 2009 to generate a list of cube elements 
(such as measures, dimension attributes, and key performance indicators) and Role Center elements 
that are not valid for the specific license and configuration keys you are using. Then, follow the 
procedures in this white paper to modify or remove the invalid elements. 

(A CustomerSource login is required to access the Default Cube Advisor Tool.) 

Who should use this tool 

If you plan on deploying Role Centers and/or the default cubes that are provided with Microsoft 
Dynamics AX 2009, you should use this tool to identify elements that must be modified or removed 

based on the license and configuration keys you are using. 

Install prerequisites 

The Default Cube Advisor Tool works with Microsoft Dynamics AX 2009 and Microsoft Dynamics AX 
2009 Service Pack 1. 

Before you can install the Default Cube Advisor Tool, you must install the following software 
components: 

Requirement How to install 

Microsoft .NET Framework 3.5 Download the .NET Framework from the Microsoft Download Center. 

Microsoft.ACE.OLEDB.12.0 This OLE DB provider is installed with Microsoft Office 2007. If you 
do not have Microsoft Office 2007 installed, you can install this OLE 
DB provider by installing the components on this Web page: 
http://go.microsoft.com/fwlink/?LinkId=98155. 

Microsoft Dynamics AX .NET Business 
Connector 

See the Microsoft Dynamics AX Installation Guide. 

Install the Default Cube Advisor Tool 

To install the Default Cube Advisor Tool, complete the following steps. 

1. Download the Default Cube Advisor Tool. 

2. Double-click the CubeAdvisorSetup.exe file.  

3. Click Yes to accept the license agreement. 

4. Specify a location to save the tool to. Click OK. 

5. After the installation is complete, click OK. 

The following files are now installed: 

 CrossRef.xlsx 

 CUBE.exe 

 CUBE.exe.config 

 EULA.doc 

 Readme.doc 

http://go.microsoft.com/fwlink/?LinkId=144755
http://www.microsoft.com/downloads/details.aspx?FamilyID=333325fd-ae52-4e35-b531-508d977d32a6
http://go.microsoft.com/fwlink/?LinkId=98155
http://go.microsoft.com/fwlink/?LinkID=99623
http://go.microsoft.com/fwlink/?LinkId=144755
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Command line options 

The Default Cube Advisor Tool is a command line tool that can generate a report listing invalid cube 
and Role Center elements. To use this tool, you must be a user in Microsoft Dynamics AX. 

The following command line options are available. 

 

CUBE.exe [-t Target] [-c "Configuration Name"] [-a Account] [-b "Cross Ref filename"] [-o "Output 

filename"] 

 

  -t {All | CUBE | RoleCenter}, to specify the result, default value is All 

  -c Configuration Name, to specify the configuration to use. System's current setting will be 

used by default 

  -a Domain account, to specify an account to logon AOS. Current logon account will be used by 

default 

  -b Cross Ref filename, to specify cross reference file name, default value is crossref.xlsx 

  -o Output file name, to specify output file name 

 

  -h or -? to show this help 

Examples 1 

Cube.exe –t ALL –o Report.txt 

This command generates a report that lists the cube elements and Role Center elements that are 

invalid and must be modified or removed. The Default Cube Advisor Tool will connect to the AOS 
specified in the current client configuration. 

Examples 2 
Cube.exe –t CUBE –c AOS2 –o Report.txt 

This command generates a report that lists the cube elements that are invalid and must be modified 

or removed. The Default Cube Advisor Tool will connect to the AOS from the specified configuration, 
which in this example is AOS2. 

Limitations and known issues 

Data required to run the Default Cube Advisor Tool is contained in the CrossRef.xlsx file. This is the 
same Excel workbook referenced by the this white paper.  

Warning: You should not modify the CrossRef.xlsx file. If you modify this file, the report generated by 
the Default Cube Advisor Tool may not be accurate. 
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Structure of the output file 

The Default Cube Advisor Tool will generate a report similar to the following example. 

 

Default Cube Advisor Tool for Microsoft Dynamics AX2009, version 1.0 

Run Date: 26-Jan-2009 15:35 

AOS: Default 

Cross Reference Document name: C:\public\crossref.xlsx 

Run Options: All 

 

 

1. Human Resources Cube 

------------------------ 

1.1 Following Query definitions (Named queries) in the DSV must be edited using BI Dev studio 

since they are used by the cube to source data 

Query name Affected Field name Recommended action 

---------------- ------------------- ------------------------------------- 

EMPLTABLE EMPLTABLE.ITEMBUYERGROUPID Remove from SELECT statement 

EMPLTABLE DIRPARTYTABLE.PREFIX Remove from SELECT statement 

EMPLTABLE INVENTSITE.NAME Fix the JOIN condition 

   

 

1.2 Following cube measures must be deleted since the fields used by these measures are no longer 

valid given the disabled configuration keys 

Measure Group Measure Name Recommended action 

---------------- ------------------- ----------------------------- 

Recruitment project Recruitment project Count Delete the measure 

Recruitment project RequisitionApprovalDate Delete the measure 

Recruitment project Recruitment project Delete the measure 

Actions Actions Count Fix or remove after fixing named query KMACTION 

Actions Actions Fix or remove after fixing named query KMACTION 

   

   

1.3 Following Calculated measures defined in the Cube must be removed or fixed since the fields 

used by the measures to source data are no longer valid given the disabled configuration 

keys. Depending on the action you have taken for dependent measures in section 1.2, you may 

remove or fix corresponding calculated measures 

Calculated measure name Dependants on Cube Measure(s)& Dimensions 

------------------------- ------------------------------------------- 

Days to Fill Actions.Actions count 

Actions.Actions 

Applicants.Status 

Number of Employees Employees.Count 
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1.4 Following Key Performance Indicators (KPI) defined in the Cube must be removed or fixed since 

the fields used by the KPIs to source data are no longer valid given the disabled 

configuration keys. Depending on the action you have taken for dependent measures in section 

1.2, you may remove or fix corresponding calculated measures 

 KPI name Dependent on Cube Measure(s)& Dimensions 

---------------- ----------------------------------------- 

Percentage of applicants interviewed Actions.Actions count 

Actions.Actions 

Employees.Status 

Percentage of applicants hired Actions.Actions 

Employees.Status 

Average days to fill positions Actions.Actions 

Employees.Status 

  

  

 

   

1.5 Following dimensions referenced by the cube need to be fixed or removed since dimension 

members source data from tables that are no longer valid given disabled configuration keys 

Dimension Attribute Recommended action 

------------- --------------- ------------------------- 

Applicants Applicants - Name Remove attribute 

Applicants Applicants Remove attribute 

Application Date of Reception Remove attribute 

Application Reason code Remove attribute 

Employee Paid vacation Remove or fix after fixing named Query EMPLTABLE 

Employee Personal days Remove or fix after fixing named Query EMPLTABLE 

   

   

1.6 Following cube and dimension relationships may need to be validated and fixed in dimension 

usage tab in BI Dev studio for the cube.  

Dimension name Recommended action 

---------------- ------------------------- 

Applicants Remove or fix 

Application Remove or fix 

Employee Remove or fix 

  

  

 

2. Role center pages 

---------------------- 

2.1 Following Role center pages need to be reviewed. Any content such as KPIs and/or Reports that 

refer to invalidated cube must be removed 

 

Role center Recommended action 

------------- ------------------------- 

Accountant Validate and Remove content that indicates errors 

Account Manager Validate and Remove content that indicates errors 

Account payable Coordinator Validate and Remove content that indicates errors 

 

 

                -----------< end of Report >------------------- 
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